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from MacCentral

Apple’s Mac Market
Share Tops 5% with
Over 30% Growth
by Jim Dalrymple, MacCentral

Apple topped all computer companies posting over
30 percent year-over-year growth rate in its Macintosh
market share. According to two market research firms,
Apple’s computer market share has surpassed 5 per-
cent.

“Apple had a very good quarter with shipments in-
creasing more than 30 percent in all regions except
Japan,” said analysts for IDC in their report. “The
growth is an excellent sign of the success of Apple’s
transition to Intel based systems.”

According to IDC’s report, the growth puts Apple’s
market share at 5.8 percent (fourth place overall),
ahead of Toshiba at 4.2 percent. Dell topped the U.S.
market with 31 percent, but suffered a negative growth
rate of -6.7 percent. The top 5 is rounded out by HP
with a 22 percent share and Gateway with a 6 percent
share.

“In the U.S. market, the focus continues to be on the

transition from desktops to notebooks, with note-
book growth being the sole bright spot while desk-
top shipments continued to decline,” said Bob
O’Donnell, vice president, Clients and Displays at
IDC.

Reporting a $546 million profit on Wednesday,
Apple also said that it shipped over 1.6 million Macs
representing over 30 percent growth from the year-
ago quarter. According to Apple CFO Peter
Oppenheimer, this represents the strongest quarter
in the company’s history.

Market research firm Gartner showed similar num-
bers for Apple. (Due to differences in how the firms
calculate PC shipments, the market share numbers
do vary slightly).

Gartner has Apple’s market share at 6.1 percent with
a 31 percent growth rate year-over-year for the third
quarter. The growth rate, according to Gartner, tops
all other computer makers and puts Apple in fourth
place overall for market share.

Topping Gartner’s list of market share is Dell (32.1
percent with -7.1 percent growth); HP (23 percent
and 6.3 percent growth); Gateway (6.4 percent with
-1.1 percent growth); Apple (6.1 percent and 31 per-
cent growth); and Toshiba (5.1 percent with 22.3
percent growth).



2

from MacNexus

My Screen Is Still Bigger
Than Yours

by Matthew Christian

In April 2003 the Interface ran an April Fool article,
titled “Apple Debuts New Ad Campaign.” It an-
nounced the termination of the “Switch” campaign
and the launching of the new “My Screen Is Bigger
Than Yours” campaign. Though written in jest, the
20-inch iMac appeared soon afterwards, and we won-
dered who at Apple read this and decided to make it
happen so
quickly. Well, it
looks like some-
one still remem-
bers that article
because, on Sep-
tember 6, Apple
added an even
bigger 24-inch
iMac to the
lineup.

Let’s start with
the $999 17-inch
iMac. This is the
education model
that replaced the
eMac earlier this
summer. There
seems little reason to get this, stripped down, crippled
model. Just get the regular 17-inch, which costs only
$200 more. Why? It has a faster processor, a
SuperDrive rather than a combo drive, twice as much
RAM and L2 cache, a separate graphics card rather
than sharing the system RAM, Bluetooth and a re-
mote. So despite the fact a sub-$1000 iMac exists, it
is not worthy. This brings us to the three models with
merit.

Three sizes and speeds are available: 2GHz (17-inch),
2.16GHz and 2.33GHz (20-inch & 24-inch). All come
with 128MB VRAM, while the 20- and 24-inch have
an option for 256MB. Although all come with stan-

dard 1GB RAM, it takes up both the memory slots
in the form of two 512MB cards. To get the maxi-
mum 3GB memory, it takes 1GB in one slot and
2GB in the other, so if you want to save money and
change it yourself the two 512’s must be removed.
It would be far better to configure the standard 1GB
as a single card leaving one slot free to upgrade.
But Apple wants to sell you overpriced RAM. On a
positive note, the VESA mount returns on the 24-
inch model, along with adding one FireWire 800
port. (Editor note: VESA is an adapter that allows
one to mount the iMac on wall mounts or articulat-
ing arm mounts.) The most significant upgrade on
all the iMacs is the Intel Core 2 Duo processor.

Apple claims a
speed increase on
the 2.33 GHz ver-
sion of 1.5 times
greater than the
original 2GHz Core
Duo processors.

The Mac minis re-
ceived faster Core
Duo processors,
too. Now all Macs
run on dual core
processors. The
mini Core Solo was
retired with this up-
date. Prices on the
mini remain at
$599 and $799. So

what happened to the much touted $500 Mac mini?
It vanished along with the last G4 PowerPC model
and has not returned. In its original concept, the mini
was to be an inexpensive Mac to entice Windoze
fans to try a Mac. Every other Mac has become less
expensive over the years, so why is the mini getting
more expensive? The current iMacs have dropped
in price by $100 on the 17-inch and $200 on the 20-
inch. Even the new 24-inch costs $200 less than the
original 20-inch did two years ago. Was there no
pricing advantage in switching to Intel Inside? At
these prices, I could not recommend the Mac mini
to new users, but do so an iMac.

Con’t on page 3, Bigger
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Although neither the iMac nor Mac mini is a new
model, the Core 2 Duo on the existing iMac does
represent a significant upgrade. Once again my be-
lief to never purchase the first version of any Mac,
but to wait at least for its first upgrade, has proven

true. The faster processors, and on the iMac more
memory, lower price and larger size, made it worth
the wait.

One has to wonder how far off a 30-inch iMac is
.......

Con’t from page 2, Bigger

Opinion: An Apple for the
enterprise?
Tom Yager, InfoWorld - IDG News Service

Like it or not, buyers of x86 servers, clients, and

workstations face a major platform shift as the 32-

bit CPUs, operating systems, and applications slowly

fade into history. That historic migration will have

dramatic impact. After all, 64-bit computing

revolutionized RISC-based UNIX systems, allowing

them to step into roles dominated by mainframes and

minicomputers. Something similar is sure to occur

with PC servers as they muscle up with the huge

horsepower and memory elbow room inherent in 64-

bit computing.

Yet one factor keeps getting pushed aside as we obsess

over hardware progress: humans. Among the demands

we make of new technology, raising human

productivity should top the list. And although 128-

bit registers have productive effect, usability has a

magnitude more impact.

That’s why Apple’s latest Macs and OS deserve a

good, hard look as mainstream enterprise fare.

Apple accepts that raising user and administrator

productivity is the responsibility of the core platform.

As Macs achieve 64-bit ubiquity — a journey

furthered by the September delivery of new 64-bit

17-, 20-, and 24-inch iMac one-piece desktops — and

the Leopard  (OS X 10.5) operating system/

application platform stalks its way to a spring 2007

release, Apple is promising the benefits of next-

generation nimbleness and power to the desks, laps,

and consoles of users and server administrators alike.

Even non-Mac users acknowledge the advanced

usability. So why do most purchasers of commercial

and enterprise systems ignore Macs when they get

serious about buying?

In truth, the objections are well-known. Most have

persisted for a while. Many are rooted in legitimate

concerns, but others deserve push back, especially in

light of Apple’s latest offerings. Read on, and decide

for yourself whether you think Macs have earned —

or will soon warrant — a spot on your enterprise short

list.

“Macs are so expensive.”

Apple behaves as though the natural forces that shape

from MacCentral

Con’t on  page 4,  Opinion
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all other PC makers’ pricing don’t affect it. Although

Apple almost never cuts prices, however, it does

respond to the market. Mac models are upgraded to

faster CPUs and buses, larger hard drives, and faster

GPUs (graphics processing units) without Apple

raising their prices. Instead of cutting prices on

Xserve RAID arrays to make them more

competitive, Apple raises capacity. At one point,

Apple slipped a major controller board upgrade into

new Xserve RAID shipments with no fanfare. Apple

customers who time it right will always be able to

get substantially more machine for the same money

each time they repurchase a given model.

With the introduction of the Mac Pro workstation,

Apple made its first public claim in recent memory

that a Mac model is, without any disclaimers or

qualifications, less expensive than a competitor’s

comparably configured PC. Mac newcomers may

have newfound respect for Apple now that it’s

duking it out with Dell on price.

“A PC is a PC; who cares who makes it?”

The PC has come to be defined as a computer that

isn’t engineered, but merely assembled. Anyone

over the age of 8 is a Phillips-head screwdriver and

credit card away from building himself a computer

identical to the majority of systems — those being

one- and two-socket desktops and servers — that

first-tier PC makers offer. In essence, those vendors

have become brokers for systems designed and

made in Asia.

As do most other first-tier PC makers (Dell being a

notable exception), Apple contracts out the assembly

of its systems. But Apple does all of its hardware

engineering in-house. Neither you nor any of

Apple’s competitors could turn off-the-shelf

components into a machine of comparable quality

and functionality in the same price range as a Mac.

Apple’s engineering ingenuity shows itself most

plainly as consumer gimmickry with hidden

practicality, such as the MacBook’s iSight Webcam

or the Front Row infrared remote.

From the perspective of a steely eyed IT buyer, how

is a Mac not like a garden-variety PC? For one thing,

Macs have virtually unlimited life spans, as reflected

in their resale value. Macs are fast, their chasses are

indestructible, and OS X is solid as a rock. And of

course, if you buy the usability argument, Macs are

the only computers that run OS X.

“It’s a proprietary platform.”

If that objection is a showstopper for you, where do

you propose to go? HP, IBM, Microsoft, Novell, Red

Hat, Sun Microsystems, and Apple are all in the

business of selling proprietary solutions.

Contrary to popular belief, the Mac platform is more

open than many. Macs will run software written for

UNIX- and POSIX-compliant operating systems —

although code written in native languages must be

recompiled for the Mac from source code. The Mac

runs Java client and server applications directly using

a Java virtual machine that Apple developed,

validated, and maintained. Two Java application

servers, JBoss and WebObjects, are bundled with OS

X Server. OS X includes stable editions of dynamic

languages, including Perl, Ruby, PHP, Python, and

JavaScript. PDF, HTML, XML, and OpenGL are

among standards implemented as OS X platform

intrinsics, again, using designs developed in-house.

Moreover, Apple publishes most of the source code

for OS X — primarily the system software,

commands, and utilities that reside below the

presentation layer — as the Darwin open source

project. After a long delay, Apple recently made the

source code for Darwin x86 available online. Apple

Con’t on page 5,  Opinion

Con’t from page 3,  Opinion
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Evening Meetings
There has been new interest in the evening meeting
format and Don Diehl is working on setting up a
regular time and day. At this time the schedule is
not finalized. If you are interested in attending the
evening meeting call Don at 377-8191.

took over stewardship of Darwin and a sister project

called DarwinPorts, which is a repository of ready-

to-compile open source applications validated for

the Mac.

Intel-based Mac hardware is proprietary only insofar

as its design makes it possible for OS X to tell the

difference between a Mac and a non-Mac PC. Salient

details of the Mac’s design are public and thoroughly

documented so that developers working in OS X or

another x86 operating system can fully exploit the

Mac’s features. The Mac boots with the standards-

based Extensible Firmware Interface instead of a

closed, proprietary BIOS, but Apple includes EFI

extensions that transparently support operating

systems that don’t yet work with EFI.

“Why invest in OS X when Vista is going to wipe it

off the map?”

If imitation is the sincerest form of flattery,

Steve Jobs is blushing. Apple Vice President

Bertrand Serlet held the keynote audience at Apple’s

2006 Worldwide Developer Conference in a state of

disbelief with a presentation showing that Vista’s

design is rooted in OS X Tiger to a degree that even

a die-hard Mac zealot would find incredible.

When Vista ships, Apple will be delivering all of its

new Macs with OS X Leopard. And if you’re hung

up on Vista, the third-party Parallels Desktop will

run it at blistering speed as a guest OS under OS X.

There will be no vice versa in Vista’s favor.

“I can’t manage a network of mixed platforms.”

Nobody wants to learn yet another set of proprietary

management tools. But administrators don’t have to

resort to the proprietary to keep a mix of systems

running.

The Mac shares common ground with all UNIX and

POSIX systems. Management tools with open source

will recompile and run on OS X — which

incorporates X Window System, VNC, and secure

shell servers and clients. Microsoft offers a free

download of a fast RDP (Remote Desktop Protocol)

client for the Mac. Parallels Desktop will run the

native management tools you need for any x86 OS.

You will find specific guidance from Apple and in

the Mac community for wiring the standard SNMP

support in OS X and Xserve RAID into commercial

Con’t from  page 4, Opinion

Con’t on page 7, Opinion
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Disclaimer
The KMUG Newsletter is a compilation of information related to the Macintosh community or areas
which impact Macintosh computing. Content comes from a variety of sources: contributions, other
user groups or internet news sources. All articles are given full credit for the author and it’s source.
The information presented in the KMUG Newsletter does not reflect the opinion of KMUG, but is

presented for it’s informational content.

Meeting Program
for

November 16th
Guest Speaker

Brad Weiger
Apple Rep. from Comp USA

Topic

 Chip Differences: Intel vs G5
Details:

Brad will discuss these issues

and demo a MacPro Tower

Luncheon  Meeting

KMUG Minutes
October 19, 2006

Don Diehl, President, opened the meeting with 25
members attending.  He said that there will be an
evening meeting on the second Monday of the
month which is November 13 at 6:30. Roy
Kouffroath will show a movie of the Flight
Museum at this meeting.

There was also some discussion about officers for
the upcoming elections.

Dick Nerf gave a demonstration of Delicious
Library which is a cataloging program for books,
games, CD,s and movies using iSight or a web cam
to scan in  UPC bar codes. It is possible to buy an
inexpensive Bar Code Scanner. If an old book
doesn’t scan, you can type in the ISPN# and then
search. The program goes to amazon.com and finds
the info. The program has shelves to hold the item
and a place to say where in your house the actual
place is.  It also can keep track of borrowers. Dick
has sent out an email telling how to get this program
with a member discount.

Questions and remarks:
 It was mentioned that Apple Care can be purchased
at a much lower cost at lacomputing.com. A
problem with the Microsoft Office 2004 Demo that
won’t go away. Suggestion was: Get info - open
with - and then change all. A problem with waking
from sleep — go to Apple/Discussions.  Also Frank
Hartung can advise on a solution. There was a
discussion about publishing a list of members
names and eMail addresses.

submitted by:
Phyllis Robie

Evening  Meeting

KMUG Minutes
October 9, 2006

Don Diehl, President, called a special evening meeting
to check on the feasibility of holding further evening
meetings. It was decided to try it to see how much
interest there will be. Don will send out a notice of
the date and time of the next meeting.

Don gave us a very enthusiastic run down of his new
Pentax K100D SLR digital camera and showed a
number of pictures demonstrating the “stop vibration”
feature and the results of shooting in low light.

Bruce fielded questions and comments from the 12
attendees. It was noted that in iTunes 7.0.1 if you hold
down the option key while opening the program, a
dialog box will come up allowing you to choose
different libraries if you have more than one. Also in

Con’t on  page 7, Minutes



7

Need some technical assistance?
There are several local people who are in the business of providing technical assistance
for the Mac. You may have seen and heard them making presentations and answering
questions at KMUG meetings. If you need help, look at the Professional Technical
Assistance Referral  area on the KMUG Website.

http://www.homepage.mac.com/kmug1

Con’t from Page 6, Minutes
iTunes it is a good idea to look at it’s Preferences
under Playback to see if the Sound Check button is
marked which helps keep sound on an even level.

Bruce also pointed out that there is much to learn by
going to Apple/Support/Discussions and then the
different categories of subjects to see other users’
problems and responses and discussions.

submitted by:
Phyllis Robie

management solutions from HP, IBM, and others.

But make no mistake, when you have to go to the

command prompt, the Mac’s quirks most certainly

will get in the way. If you’re used to a System V

UNIX or Linux OS, the locations of files, the boot

sequence, and the contents of the process tree will

mystify you at first. If you’re accustomed to system

management by custom Perl or shell scripts, your

scripts will need some conditional code added to

accommodate the Mac.

One quality all Mac systems share makes them a

delight to manage: From the administrator’s point of

view, all Macs are identical. The policies you set

using OS X Server are applied uniformly to PowerPC

and Intel Macs, to mobile and stationary users. When

you have an administrative task, such as installing

an application or an update on all of the Macs on

your network, Remote Desktop 3 will handle it for

you. The combination of Remote Desktop, Server

Manager, Server Monitor, and RAID manager is all

the Mac-specific management you’ll need, and it

won’t take you an hour to learn the whole stack.

“OS X Server is unproven in critical, high-

availability, and large-scale deployments. It’s an

enterprise wannabe.”

OS X Server may actually be an enterprise “don’t-

wannabe.” Apple has lowered its sights with a server

campaign that runs under the tag line, “No IT

department required.” Small and midsize businesses

are Apple’s server target.

No wonder. Apple’s track record in the enterprise is

not exactly stunning. OS X couldn’t get sufficient

uptake from ISVs on whose applications enterprises

rely. Windows, established RISC UNIX, and Linux

already fill the top three spaces in the market.

Yet Apple’s pursuit of UNIX certification for OS X

Leopard bodes well for the future. Today, native

commercial software must be adapted to and

separately validated on the Mac, but if OS X passes

the full UNIX-compliance suite, ISVs will be a

recompile away from delivering OS X server

software.

Meanwhile, a clutch of high-profile customers

running Xserve and Xserve RAID bolster Apple’s

enterprise credentials. Several broadcasters,

including CNN, use Mac enterprise gear to create,

Con’t from page 5, Opinion

Con’t on  page 8, Opinion
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store, and air content. The U.S. military hauls Mac

servers into the field and out to sea. Mac systems

are widely deployed in academia, medicine, high-

performance computing, science, film, and other

fields where one server failure is cause for hauling

a machine to the curb.

“Apple controls the availability of systems, parts,

upgrades, and service.”

This incontrovertible truth is one of the greatest

points of contention between Apple and its

customers. Apple maintains a viselike grip on

distribution, pricing, and service, and with the

spreading of Apple retail stores, its grip is tightening

such that if it chose to, the company could shut down

its reseller program entirely and continue to function

without a hiccup. The merest whiff of that possibility

sent resellers leaping to their fax machines and

lawyers.

When challenged persistently on an issue, however,

Apple tends to loosen its grip. For years, for

example, Apple software would only burn DVDs

on Apple-branded internal drives. The software

shipped with Macs was limited to burning one hour

of video to a DVD. After a lot of yelling that Apple

pretended not to hear, and after users hacked a couple

of widely used work-arounds, Apple eventually gave

in on both issues. It’s Apple’s nature to try to squeeze

its users now and then, and it’s Mac users’ nature to

tell Apple to go screw itself when that’s what’s called

for. It’s nice to have people with attitude watching

your back.

“Apple’s got a smoke-and-mirrors hack that makes

Macs run Windows.”

Boot Camp is a hack that alters a running copy of

OS X so that the user can choose to run Windows

instead at boot time. It is a very limited solution,

one that Apple branded a beta by. Boot Camp seems

intended to prove that, true to its word, Apple did

nothing to keep Windows from running on an Intel

Mac.

Dual-booting between operating systems is no more

practical a solution for professional Mac users than

it is for anyone else. In most cases, users will want

to run OS X and another OS side by side. That’s a

job for virtualization, and because OS X will allow

itself to operate as a guest OS, it has to host other

x86 OSes.

This it does, exceedingly well, with help from

Parallels Desktop. This solution is imperfect —

display updates could be faster and there’s no support

for 64-bit guests — but it’s fast, effortless, and

compatible with every imaginable 32-bit guest OS.

Imposing small overhead, Parallels Desktop is an

entirely practical means of running alternate

operating systems on a Mac.

“Apple’s product line is tiny. All other Intel OEMs

focus on choice.”

Apple’s catalog has just eight systems: iMac, 15-inch

MacBook Pro, 17-inch MacBook Pro, white

MacBook, black MacBook, Mac Pro, Xserve, and

Mac mini. Apple departs from its Intel OEM brethren

that feel it’s necessary to save a place in their product

lines for every subvariety of Intel CPU. With Apple,

you pretty much choose the shape you like best, and

that determines what Apple puts inside.

Almost. When it cut the number of base

configurations, Apple also raised the number of

configure-to-order options. You can’t order a Mac

Pro with a Celeron D, Pentium 4 Extreme Edition,

or a single Core 2 Duo processor, but you can dial in

up to four hard drives, two optical drives, and one of

several graphics cards. Nonetheless, if you long for

Con’t from Page 7, Opinion

Con’t on  page 9,  Opinion
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options in low-level items such as CPUs and chip

sets, look elsewhere.

“Apple picked Intel when it should have gone with

AMD.”

So far. AMD’s road map will take the company

places that Intel can’t go. Sooner rather than later,

Apple may find its margins and its ability to compete

restricted by its CPU supplier, just as occurred before

with IBM and Motorola. If necessity dictates it,

Steve Jobs will take the stage at Macworld to

welcome AMD as a supplier and intimate that Apple

had planned that move all along. Today, Macs may

or may not appeal to you as enterprise machines.

But don’t underestimate the company’s drive to

compete.

Con’t from page 8,  Opinion

from MacWorld

OS X &  Mac 911 Tips
Scroll Images in Tiger's Preview

By Rob Griffiths
If you use OS X 10.4's Preview to look at or
manipulate images, one thing that may bother you is
the apparent lack of a scrolling tool. In most graphics
programs, the scrolling tool is represented by an icon
of a hand, so you may also hear this referred to as
the hand tool. With the hand tool, you can move about
in an image which is larger than that which fits on
the screen. For instance, you might be working with
a 2,500-by-1,200 pixel image on a screen with a work
area substantially smaller than that. So if you're
viewing the image at full size, you'll have both
horizontal and vertical scroll bars. Sure, you could
use the scroll bars to move about, but the problem is
that they only move in one direction -- so to move
diagonally, you need to drag one bar, then the other,
etc., until you get to where you want to go.

The hand tool, though, simply lets you click and drag
to move the image around within the visible work
area. This makes is simple to go just where you need

to, without having to flip between two different scroll
bars. Sounds useful, and indeed, if you open a PDF
in Preview, you'll see that you have scroll tool
available -- just press Command-1 (Tools -> Scroll
Tool), or choose the first icon on the Tool Mode
section of the toolbar. (Note that the scrolling tool
will only work if you are viewing the image at actual
size, and that size is larger than the window size.)

But open an image in Preview, where such a tool
would be really useful, and it's nowhere to be seen.
Command-1 does nothing, and if you look, the Scroll
Tool menu item is grayed out. There's also no Tool
Mode section on the menu bar, nor can you add one
via the Customize Toolbar menu item. However, if
you press and hold the space bar with an image open,
you'll see the cursor change to a hand. There is it, the
hidden scrolling tool!

Now, it's a bit of a pain to hold down the space bar
while dragging. But you don't have to -- once you
start dragging, you can release the space bar. The
cursor will switch back to that of the select tool, but
you can continue dragging. If you need to reposition
the mouse, though, you'll have to press the space bar
again to re-enter the scrolling mode.

While it would make much more sense for Apple to
simply enable the Scroll Tool menu item with images
open, at least there is a workaround. (And this
shouldn't be an issue in pre-10.4 versions of Preview,
as I don't believe they had this split personality for
tools available in PDFs and images -- I might be
wrong about that, though.)

Build Smarter iPhoto Albums
By Rob Griffiths

iPhoto’s Smart Albums are great when you want to
find a subset of your photos based on certain matches
— all images newer than last week, for instance. But
what if you want to do something more complex, like
finding pictures of your cousins Bill and Will? Here’s
an undocumented trick to add some degree of
flexibility: If you’re using iPhoto 5, you can employ
a number of wildcard characters when building Smart
Albums based on the “Any Text” criteria. (You need

Con’t on  page 10,  Tips
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to have given your photos descriptive names, applied
Keywords, or typed comments in the Information
field for this to work.)

iPhoto 5 supports these wildcard characters: the
asterisk (*), which stands for “any number of
characters, including none”; the question mark (?),
which stands for “any one character”; and square
brackets ([ ]), which are used to select from a list of
characters, or to just quote the actual asterisk and
question mark, in case you wish to actually search
on those characters.

In each of these examples, the starting point is a new
Smart Album (File: New Smart Album) with the
criteria “Any Text” and “Starts With.” Now consider
the following possible contents for the actual search
string:

• T?m: Match all photos that contain the string Tim
or Tom, but not Them (since there are only three
characters in our search string).

• B*e: Match any photos that contain a string that
starts with a B and ends with an e. So you’d see
matches for Base and Bike and Brittle and even Be.
You would not, however, see matches for Brighten,
since that’s got an extra character at the end.

• B??t: Finds Boat and Belt but not Burnt (since that’s
got three characters in the middle, and we’ve only
allowed for two).

• Mari[ao]n: Finds only those images whose text
matches Marian or Marion.

• C*r*: You’ll get lots of matches here, as it’s
basically saying “find any text that start with a C,
has any number of following characters, then an r,
and then any number of additional characters
(including zero).” As such, Car, Cars,
Characterization, and Chart are all examples of words
that would match.

Finally, what if you want to match an actual * or ?
character? Just enclose the special character in square
brackets, like this: Kellie[?]. This search would only
match images that were marked with the text Kellie?

— perhaps you’ve got some people you haven’t quite
yet identified in your images.

Note that these wildcard characters will probably
prove most helpful in the middle of your search terms
— iPhoto already does a kind of “any match” search
for longer matches in your library. For instance, a
search on “Tim” will also find pictures labeled
“Timmy,” which is the same result you’d get with a
“Tim*” search.

When you add wildcards to iPhoto’s Smart Albums,
you can find almost any subset of images. Given the
similarities between iPhoto and iTunes, you’d think
this same thing would work in iTunes... sadly, at least
as of today, you’d be incorrect. For now, this is an
iPhoto-only trick.

Fishin’ for Permissions
By Christopher Breen

At a recent visit with MacChUG, the Macintosh user
group in Chico, Calif., the subject of repairing
permissions came up — specifically the question of
why widgets seem to unfailingly have a problem.
This is a common enough misconception that I
thought I’d tell you what I told the Mac users in
Chico.
When you launch Disk Utility, select a volume, click
the First Aid tab, and click either Verify Disk
Permissions or Repair Disk Permissions you will see
a long series of entries that begin “We are using
special permissions for the file or directory X,” where
X is a widget.

If you’re a long-time OS X users who’s repaired
permissions on a regular basis, you may believe that
anything that First Aid reports to you should be dealt
with. Not in this case.

With the advent off widgets, First Aid has become
chattier, much like a barroom companion who drones
on and on without ever getting to the point of his
long-winded story. In this case, First Aid lists widget
after widget, offering that each is using a special
permission (33188). The problem is that it fails to
sum up the report with a “Oh, and you needn’t worry
a tinker’s damn about these special permissions. You
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can bang on that Repair Permissions button from her
until doomsday and you’ll see this same list of entries
every time.”

In short, feel free to ignore any entry that begins “We
are using special permissions.”

By the way, if you’re looking for information on the
ways and means of permissions, be sure to take a
look at Brian Tanaka’s Take Control of Permissions
in OS X, an excerpt from his ebook of the same name
appearing at http://www.macworld.com/2006/03/
secrets/tcopermissions/index.php/?lsrc=mwweek-
0320 .

Override Pages’ Template Chooser Default
By Rob Griffiths

Here’s a quick but handy timesaver if you’re using
Pages 2, the word processing nee page layout
program included in iWork ’06. As configured from
Apple, Pages opens its Template Chooser every time
you open a new document. At first, this is quite
reassuring and lets you explore the multitude of
available templates.

Over time, however, you’ll probably find there’s one
template you use most of the time. You can set your
preferred template to be used automatically when
you open a new document via Pages’ Preferences,
in the General section. Once you’ve set that
preference, you’ll never see the Template Chooser
again. Ah, but what to do when you do want it?
In previous versions of Pages, you did the
Preferences switch — open Preferences, set the
General pop-up to display the Template Chooser,
close Preferences, then hit Command-N to create a
new document. When done, open Preferences again
and set your preferred template back as the default.
Ugh.

In the new version of Pages, a hidden keyboard
shortcut has made the process much simpler. And,
like many of the best OS X features, it’s seemingly
undocumented. Instead of mucking about with

Preferences, just hold down the Option key prior to
selecting File: New from the menus. Presto, instant
Template Chooser! Unfortunately, you can’t further
shortcut the process by using Command-Option-N;
you have to use the File menu itself. And as noted,
this only works in the new Pages 2. Users of the
previous version are still stuck with the Preferences
switcheroo.

Group Finder Spotlight Results
By Rob Griffiths

As noted previously I have some issues with
Spotlight. That doesn't mean, however, that I never
use it. In particular, I use the Spotlight's Finder search
more often than the full-blown Spotlight search. As
long as I'm relatively specific about what I'm looking
for, the results are usually relatively quick and
relevant.

But there's one thing I miss in the Finder's Spotlight
results that's available in the full-blown Spotlight
search results (when you use the Show All option),
and that's the ability to do meaningful sorting and
grouping of the results. In the large Spotlight Results
window, you can group the results by Kind, Date,
People or Flat List (ungrouped), and then sort within
those groups on Name, Date, Kind, or People. If you
run a simple Finder search, though, such niceties are
apparently missing. You can switch to List view (by
pressing Command-2, or View -> as List), which will
let you sort by one of the column headings, but you
can't sort and group using List view.

There is, however, a way to sort and group (in a
somewhat limited matter) the Finder's Spotlight
search results. Run your search first, then select View
-> Show View Options (or just press Command-J).
This will bring up the Finder's View Options dialog,
but with some customized settings for the search
results window. You'll be able to group by Kind or
Date, and sort by Name, Date, or Kind. While this
isn't quite as powerful as the grouping and sorting
options offered in the Spotlight search results
window, it's better than not being able to do anything
at all with the results.

Con’t from Page 10, Tips



------------------------------ ABOUT MEMBERSHIP ------------------------------
To join Kitsap Macintosh User’s Group

 send name, address (e-mail and snail mail), phone number and dues ($20/year) to:
KMUG

P.O. Box 1271, Silverdale, WA 98383
or come to one of our meetings and sign up!
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KITSAP MACINTOSH USER’S GROUP
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KMUG’s home page is now at:
http://www.homepage.mac.com/kmug1
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